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MEJORAR LA EFICIENCIA DEL DISEÑO CON PLANTILLAS DE PROYECTO

RESUMEN

¿Repite innecesariamente pasos que retrasan su flujo de trabajo de diseño? ¿Siente la presión de este entorno de diseño moderno 

y acelerado que exige entregas continuas de productos y ciclos de diseño rápidos? Descubra cómo las plantillas de proyecto 

pueden ayudar a acelerar el tiempo de configuración del proyecto al estandarizar sus objetivos iniciales de configuración.

LA NECESIDAD DE PLANTILLAS DE PROYECTO

Los ingenieros actuales están sometidos a una presión constante para terminar los proyectos con calendarios de producción 

cada vez más cortos. Sin embargo, se ahorra tiempo muy valioso al iniciar un nuevo proyecto utilizando Plantillas de proyecto. 

Aunque hay muchos tipos de proyectos dentro de Altium Designer (por ejemplo, FPGA, Core, Embedded, Integrated Library y 

Script), nos enfocaremos en la plantilla PCB Project.

En Altium Designer, cada diseño comienza con un proyecto. Con un proyecto creado, los documentos de diseño, los archivos 

de configuración, las librerías, etc., se añaden y se vinculan entre sí para proporcionar un entorno de diseño centralizado. 

Si bien no todos los proyectos son iguales, cada proyecto tendrá algunos parámetros de configuración iniciales y archivos 

similares. Podemos aprovechar el uso de las Plantillas de proyecto para ayudar a rellenar parámetros, archivos de diseño, 

librerías, trabajos de salida y otros tipos de documentos para ayudar a reducir el tiempo de instalación inicial de un proyecto 

de PCB de Altium Designer.

CREACIÓN DE LA BASE DE LA PLANTILLA DEL PROYECTO

La creación de un nuevo proyecto en Altium Designer implica el uso de un Asistente para proyectos. El Asistente para proyectos 

le permite seleccionar entre las plantillas de proyecto predeterminadas o crear su propia plantilla desde cero. La ubicación 

de la carpeta de Plantillas se especifica durante la instalación inicial (por ejemplo, se configurará en la ubicación de la carpeta 

"Documentos compartidos" como se muestra en la Figura 1).

Figura 1. Ubicación de plantillas, librerías y ejemplos

Una vez finalizada la instalación, puede revisar la ubicación de la Plantilla de proyecto desde Altium Designer si abre las 

preferencias DXP, en DXP » Preferences » Data Management » Templates. Además, puede hacer clic en el botón "Manage 

Templates" del asistente de New Project para abrir la configuración de la ruta para la carpeta de plantillas.
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Piense en una Plantilla de proyecto como un proyecto global. Cuando se crea un nuevo proyecto utilizando el Project Wizard 

(File » New » Project), se creará una copia de la Plantilla de proyecto seleccionada con el nombre especificado en la ubi-

cación que especifique, como se muestra en la Figura 2.

La selección de la plantilla de proyecto <Default> es un caso particular y necesita alguna explicación adicional. Si se ha 

especificado un proyecto en sus preferencias en DXP » Preferences » System » New Document Defaults para la 

categoría principal del Proyecto, el proyecto al que se hace referencia se copiará como se muestra en la Figura 3. Si no se ha 

especificado ningún proyecto, se creará un proyecto genérico en blanco.

Puede establecer el proyecto <Default> en sus preferencias si sigue estos pasos:

1. Abra los nuevos documentos por defecto en DXP » Preferences » System » New Document Defaults. 

2. En Document Kind, seleccione el botón ... ubicado junto a PCB Project. 

3. Seleccione el proyecto que desea utilizar para configurarlo como su proyecto de documento nuevo predeterminado.

Figura 2: asistente para proyectos

Figura 3: nuevos valores predeterminados del documento
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AÑADIR CONTENIDO A LA PLANTILLA DE PROYECTO

Las plantillas de proyecto se pueden considerar como un armazón inicial para crear nuevos proyectos. La plantilla puede 

contener esquemas, archivos de trabajo de salida de PCBs, librerías y otros tipos de archivos. Cuando se selecciona la plantilla 

en el cuadro de diálogo New Project, el nuevo proyecto creado duplicará el contenido de la carpeta seleccionada con el 

nombre de proyecto especificado. Además, se pueden asignar parámetros en las opciones de proyecto que se pueden utilizar 

al nivel de documento de diseño y en los archivos de salida.

AÑADIR PARÁMETROS

Los parámetros pueden introducirse en Altium Designer desde las opciones Project Parameters, Document Parameters, y 

Component Property Parameters.

Los Parámetros de componente se pueden utilizar en la exportación de datos, como una Lista de materiales. Los parámetros 

de Documento y Proyecto se pueden utilizar para visualizar los valores de parámetro en la hoja y las impresiones, y también 

se pueden utilizar para exportar datos.

Para los documentos esquemáticos, hay plantillas específicas que se pueden adjuntar para definir el tamaño de la página 

esquemática, el bloque de títulos y los parámetros del bloque de títulos. Los parámetros del documento esquemático tienen 

una prioridad más alta que los parámetros del proyecto, por lo que queremos establecer parámetros a nivel de proyecto para 

que no entren en conflicto con los parámetros del documento.

Los parámetros de prioridad más alta sustituirán a los parámetros de prioridad baja si tienen el mismo nombre de parámetro. 

A continuación, se enumeran las prioridades de los parámetros, desde la prioridad más alta a la más baja:

1. Parámetros de variante (proyecto) 

2. Parámetros esquemáticos (documento) 

3. Parámetros de proyecto (proyecto)

Tanto los parámetros de Variante como los parámetros de Proyecto se definen en el nivel de Proyecto. Los parámetros 

esquemáticos se definen en el documento esquemático y se pueden asignar manualmente o importar utilizando un modelo 

esquemático. El documento de PCB no tiene parámetros propios que se refieran únicamente a los Parámetros de proyecto 

asociados. Los Parámetros de nivel de proyecto abarcan todos los documentos fuente dentro del proyecto, proporcionando 

así una ventaja adicional cuando se implementan en nuestras plantillas.

Los parámetros tienen una variedad de usos que incluyen las instancias de bloques de títulos utilizando Cadenas especiales, 

así como la inclusión en impresiones y archivos de informes, como la Lista de materiales. Las Cadenas especiales consisten en 

texto colocado (Place » String) con el que su valor hace referencia a un valor de parámetro establecido en la pestaña Project 
Options » Parameter o en la pestaña Design » Document Options » Parameter del documento esquemático. Edite las 

propiedades de la cadena o presione la tecla tab durante la colocación para establecer el valor.

En un esquemático, una Cadena especial hace referencia al 

parámetro con un signo "=". En una PCB, se hace referencia a una 

Cadena especial utilizando un punto ".". Por ejemplo, si se define 

un Parámetro en Project Options como ProjectTitle, el valor 

asignado correspondiente puede visualizarse en el esquema 

colocando una cadena con el valor establecido en =ProjectTitle, 

como se muestra en la Figura 4.

Figura 4: cadena especial en el esquemático
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Al editar las propiedades de la cadena en la PCB en el campo Propiedades, introduzca un punto "." y aparecerá la lista de 

selección. Por ejemplo, en la Figura 5, la Cadena especial se establecería en .ProjectTitle

Figura 5: cadena especial en la PCB

Puede encontrar más detalles sobre el uso de cadenas especiales aquí: http://techdocs.altium.com/display/ADRR/Sch_Obj-

Parameter((Parameter))_AD

AÑADIR CONTENIDO DE DISEÑO

Las plantillas de proyecto predefinidas que se instalan con Altium Designer proporcionan un punto de partida para esquemas 

y PCBs que incluyen PCI, ISE y varias otras tecnologías. Utilizaremos la plantilla PCIe de Altium Content Vault y la agregaremos 

a nuestras plantillas. Se puede seguir el mismo proceso si está creando una nueva Plantilla de proyecto desde cero.

Las plantillas de proyecto se pueden descargar desde Altium Content Vault o desde la sección AltiumLive Resources » 
Design Content, y seleccionando Template Designs.

Utilizaremos la tarjeta PCI Express mini Half-Mini type H2 de la sección Altium Content Vault Board Templates en Design 
Content » Template Designs » PCI Express.

Para acceder al vault de contenidos de Altium Designer haga lo siguiente:

1. Abra sus preferencias de Altium Content Vault desde DXP » Preferences, Data Management » Vaults.

2. Active Altium Content Vault haciendo clic en el botón Add Altium Content Vault. (Esto debería permitir el acceso 

a Content Vault en DXP » Vault Explorer)

3. En las carpetas Vault, Board Templates » Design Content, hay una serie de tipos de plantillas disponibles. 

Al hacer clic con el botón derecho en el Diseño de plantilla y seleccionar Download desde la ventana emergente 

Operations, la plantilla de diseño podrá descargarse como se muestra en la Figura 6.

Figura 6: descarga de la plantilla de diseño de proyecto de ejemplo
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Ahora, descargue la plantilla a una carpeta temporal y copie el contenido de la carpeta Design a la ubicación de la carpeta 

Template que vimos anteriormente como se especifica en las preferencias DXP. Una vez copiada, la nueva plantilla de diseño 

está lista para su uso. Todavía hay algunos otros pasos de configuración que podrían realizarse para nuestra plantilla, como 

crear un archivo OutJob o actualizar los Parámetros del proyecto, pero vamos a utilizar esta plantilla de proyecto copiada para 

iniciar un nuevo proyecto.

CREAR UN PROYECTO DESDE UNA PLANTILLA DE PROYECTO

Vamos a crear un nuevo proyecto basado en la plantilla PCIe copiada en la carpeta de plantillas. Siga estos pasos en Altium 

Designer:

1. Seleccione File » New Project 

2. Para Project Type, seleccione PCB Project. 

3. Seleccione la plantilla de proyecto PCI Express Mini_3000x2680_52PIN_Half-Mini-Type H2. 

El nombre de la plantilla mostrada coincidirá con el nombre del proyecto en la carpeta de la plantilla. Observe que no se 

muestra ninguna vista previa.  La vista previa solo se muestra si hay un Windows Metafile (EMF) generado con el mismo 

nombre que el proyecto en la misma carpeta que la plantilla.

4. Haga clic en OK una vez que se haya especificado el nombre y la ubicación del proyecto. Es opcional si desea 

comprobar la opción Create Project Folder, que creará una subcarpeta en la ubicación de destino con el nombre del 

proyecto.

Este proyecto contiene la base del esquemático con el conector PCI y los nombres de red asignados. La PCB correspondiente 

es una tarjeta genérica en blanco como se muestra en la Figura 7, y está lista para comenzar un nuevo diseño.

Figura 7: documentos de PCBs y esquemáticos generados a partir de una plantilla

CREAR SU PLANTILLA

Si planea cambiar la plantilla de proyecto predeterminada en DXP Preferences para apuntar a un proyecto diferente, se 

recomienda crear un proyecto que no esté completo, sin archivos, y copiarlo en la carpeta de plantillas. Con este método, se 

puede crear fácilmente un nuevo proyecto en blanco desde el cuadro de diálogo New Project.

También se recomienda agregar los proyectos que cree en la carpeta Template al Control de versiones para que pueda realizar 

un seguimiento de los cambios fácilmente. Tenga en cuenta que si se desinstala Altium Designer, se eliminarán los archivos 

ubicados en la carpeta de la plantilla original instalada. Si cambia la carpeta Template a una ubicación de red, la desinstalación 

no afectará a la nueva ubicación de la carpeta.
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Si un proyecto de plantilla apunta a archivos fuera de la carpeta de la plantilla, o a archivos en una subcarpeta de la carpeta de 

la plantilla, el proyecto generado a partir de la plantilla pondrá todos los archivos a los que se hace referencia la plantilla en la 

nueva ubicación de destino del proyecto por defecto.

VISTA PREVIA DEL PROYECTO

En el Asistente para proyectos, al seleccionar una Plantilla de proyecto disponible, se mostrará una vista previa en el lado 

derecho del cuadro de diálogo.  Normalmente, la vista previa mostrará el PcbDoc asociado al proyecto, si hay alguno vinculado 

a él. Sin embargo, esto no es una vista previa en directo, sino que se genera desde un Enhanced Windows Metafile (EMF), con 

el mismo nombre y ubicación que el proyecto. Se puede exportar un archivo de previsualización EMF desde una Vista previa 

de impresión en Altium Designer al hacer clic con el botón derecho en la vista previa y seleccionar Export Metafile.

CONCLUSIÓN

Con solo un poco de trabajo preparatorio pudimos crear fácilmente una nueva Plantilla de proyecto, permitiéndole reducir el 

tiempo necesario para comenzar un nuevo proyecto en el futuro. Además de los beneficios obvios de ahorro de tiempo de 

las Plantillas de proyecto, también pueden ser extremadamente valiosos en situaciones donde usted necesita estandarizar la 

base de todos los documentos del proyecto de PCB para un equipo de ingeniería más extenso.
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